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Úvod 

Uživatelská příručka programu FlexSim byla vytvořena jako doprovodný materiál k běžné 

výuce na cvičeních v předmětu Počítačové modelování a simulace ve výrobě na Fakultě 

strojní, ČVUT v Praze. Smyslem příručky je umožnit rychle dohledat základní informace 

týkající se práce s programem, respektive informace a postupy k provedení základních 

nastavení modelu, objektů v modelu a programu samotného. Příručka nepokrývá všechny 

oblasti na výuce řešené, ale opravdu pouze ty základní. 

Příručka může rovněž posloužit všem, kteří se rozhodnou vyzkoušet volně dostupnou a 

časově neomezenou bezplatnou verzi programu FlexSim, tzv. verzi FlexSim Express. V této 

verzi nejsou oproti plné verzi k dispozici úplně všechny nástroje a funkce (např. nástroj pro 

experimentování) a je možné použít najednou max. 30 objektů v 3D modelu a max. 35 

objektů v modulu Process Flow. Nicméně stále je zde dostatek funkcí a nástrojů k simulaci 

jednodušších výrobních, logistických či jiných procesů a systémů. Tuto verzi je tak možné 

plnohodnotně použít k řešení jednoduchých podnikových problémů, ke studiu simulací a 

osvojení si práce s FlexSim.  

Poznámka: Uživatelská příručka byla vytvářena pro verzi FlexSim 20.0.x a 20.1.x, nicméně 

naprostá většina zde uvedených informací je stále platná i pro aktuální verze programu. 
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1 Registrace, stažení a instalace SW FlexSim 

Software FlexSim Express je nutné stáhnout přímo z webových stránek vydavatele – 

společnosti FlexSim Software Products, Inc., kde je třeba nejprve provést registraci nového 

uživatele. Následně je teprve možné provést samotné stažení instalačního souboru a 

instalaci SW FlexSim. Celý postup je popsán dále v rámci jednotlivých podkapitol. 

Po prostudování této kapitoly bude uživatel schopen: 

1. Provést registraci nového uživatele na webových stránkách vydavatele 

2. Stáhnout instalační soubor SW FlexSim 

3. Provést instalaci SW FlexSim 
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1.1 Registrace nového uživatele 

1. V prohlížeči si otevřeme webovou stránku vydavatele SW: https://www.flexsim.com/  

2. V pravém horním rohu webové stránky klikneme na „Try FlexSim“. 

 

3. Na nově načtené webové stránce si najdeme sekci „Register now to download FlexSim 

Express“. Zde se doporučuje využít registraci pomocí školní emailové adresy. Vyplněnou 

adresu potvrdíme tlačítkem „Sign up with email“. Není třeba mít obavy z nárůstu 

elektronické pošty. Adresu je možné v budoucnu změnit. 

 

4. V další nabídce vybereme účel registrace „Academic“ a potvrdíme tlačítkem „Next“. 

 

5. V další nabídce vybereme svou pozici jako „Student“ a potvrdíme tlačítkem „Next“. 

https://www.flexsim.com/
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6. Nabídka se modifikuje a zde vyplníme základní informace o studiu (Czech Technical 

University in Prague – Faculty of Mechanical Engineering, Undergraduate School, 

September 2021, Pavel Scholz). Vše opět potvrdíme tlačítkem „Next“. 

 

7. V další nabídce vyplníme své jméno, příjmení, telefonní číslo, zemi a po přečtení 

potvrdíme (zaškrtneme souhlas) s podmínkami. Na závěr potvrdíme registraci tlačítkem 

„Submit“. 

 

8. Do emailové schránky by měl nyní dorazit email s potvrzením o úspěšné registraci, 

pravděpodobně s předmětem „Your New FlexSim Account“. Provedeme tudíž kontrolu 

schránky a v případě potřeby zkontrolujeme i složku „Spam“. Email může dorazit 

s určitým zpožděním. 

9. Obsahem emailu je Vaše kontaktní emailová adresa a dočasné heslo pro přihlášení. 

Zároveň je zde odkaz pro přístup k novému účtu „Click here to access your account.“. 

Klikneme na „Click here“ a budeme přesměrováni na webovou stránku s přihlášením 
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k našemu nově vytvořenému účtu. (Případně budeme přesměrováni již přímo do svého 

účtu bez potřeby se přihlašovat – potom pokračujeme na další kapitolu.) 

 

10. Na nově otevřené webové stránce provedeme první přihlášení pomocí emailu a 

zaslaného dočasného hesla. 

 

11. Ihned po přihlášení provedeme změnu hesla. 
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1.2 Stažení SW FlexSim 

1. V prohlížeči si otevřeme webovou stránku vydavatele SW: https://www.flexsim.com/ 

2. Pokud nejsme přihlášeni k účtu, provedeme přihlášení. Klikneme na tlačítko „Account“ 

v pravém horním rohu. 

 

3. Na nově otevřené webové stránce provedeme přihlášení pomocí emailu a hesla. 

 

4. Po přihlášení přejdeme na záložku „Downloads“, kde je na levé straně (zelený rámeček) 

aktuální verze SW FlexSim. Zde klikneme na „Download“. 

 

5. Následně se nám objeví okno, kam chceme instalační soubor uložit. Vybereme si vhodné 

místo a dáme uložit. 

https://www.flexsim.com/
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1.3 Instalace SW FlexSim 

1. Po stažení instalačního souboru jej spustíme. Buď přímo z prohlížeče nebo např. 

z Průzkumníka Windows ze složky, kam jsme si soubor uložili. 

 

2. Objeví se nám okno instalace, kde zaškrtneme, že souhlasíme s podmínkami a klikneme 

na tlačítko „Install“. 

 

3. Následně se obvykle objeví žádost systému Windows o potvrzení provádění změn: 

„Chcete této aplikaci povolit, aby prováděla na vašem zařízení změny?“. Tuto žádost 

kladně potvrdíme. 

4. Vyčkáme dokončení instalace. V závislosti na výkonu počítače může trvat instalace i delší 

dobu. V jejím průběhu samozřejmě nevypínáme počítač. V případě potřeby je 

samozřejmě vhodné mít notebook připojen do napájení. 
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5. Po dokončení instalace se nám aktualizuje okno instalace. Protože budeme chtít SW 

FlexSim spustit jiným způsobem (viz další kapitola), zrušíme zde zaškrtnutí „Launch 

FlexSim“ a instalaci dokončíme stiskem tlačítka „Close“. 
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2 Zapnutí/vypnutí SW, volba pracovního prostředí, 

úvodní obrazovka, návod 

Kapitola se zaměřuje na představení způsobů zapnutí a vypnutí SW FlexSim, na výběr 

preferovaného pracovního prostředí a jeho případnou změnu a na představení úvodní 

obrazovky po spuštění SW. 

Po prostudování této kapitoly bude uživatel schopen: 

1. Spustit a vypnout program 

2. Spustit program s využitím dedikované grafické karty NVIDIA nebo AMD 

3. Nastavit a přepnout pracovní prostředí 

4. Orientovat se na úvodní obrazovce programu 
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2.1 Způsoby spuštění SW FlexSim 

Spuštění SW FlexSim je možné několika způsoby a může se lišit v závislosti na verzi 

operačního systému Microsoft Windows. Dále jsou představeny 2 základní způsoby: 

1. Pomocí dvojkliku na ikonu „FlexSim 2020 Update 1“ na ploše počítače. (Pokud používáte 

notebook – čtěte poznámku níže.) 

 

2. Prostřednictvím nabídky start operačního systému Windows: 

• Windows 10: Start > FlexSim > FlexSim 2020 Update 1 

• Windows 7: Start > Programy > FlexSim > FlexSim 2020 Update 1 

 

Poznámka: V případě, že máte notebook a disponujete dedikovanou grafickou kartou 

(NVIDIA nebo AMD) je vhodné ji při práci se SW FlexSim s ohledem na její obvykle vyšší výkon 

využít. (Pokud nevíte, zda máte dedikovanou grafickou kartou, i tak čtěte dále.) Spolu s tím 

je pak s ohledem na vyšší spotřebu samozřejmě vhodné mít notebook připojen do napájení. 

Jeden z možných postupů (nikoliv jediný) spuštění SW FlexSim s využitím dedikované 

grafické karty je následující. Klikneme na ikonu FlexSim 2020 Update 1 pravým tlačítkem 

myši a vybereme „Spustit s grafickým procesorem“. Zde dále vybereme Spustit s výkonným 

grafickým procesorem NVIDIA (AMD). Pokud zde tato nabídka není, nemáte dedikovanou 

grafickou kartu nebo ji není možné využít, případně je třeba využít jiné cesty. 
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2.2 Volba pracovního prostředí 

Při úplně prvním spuštění programu po první instalaci na počítač se objeví nabídka na výběr 

preferovaného pracovního prostředí s ohledem na zaměření práce uživatele. Od tohoto 

výběru se pak odvíjí i nastavení prostředí modelu, knihoven atp. Na výběr je klasické 

prostředí (Classic – General Purpose) nebo prostředí pro zdravotnictví (Healthcare). 

Vybereme prostředí Classic. Při všech dalších spuštěních budeme mít automaticky 

nastaveno prostředí Classic. 

 

Výběr je možné kdykoliv změnit, a to několika způsoby: 

1. V levém horním rohu klikneme na File > Global Preferences > Environment > Default 

Environment. Vybrat prostředí Healthcare a potvrdit dole tlačítkem Apply a OK. 

2. Do nastavení Global Preferences můžeme vstoupit také z úvodní obrazovky 

programu, kde na levé straně klikneme na dlaždici Preferences. 

3. V pravém horním rohu klikneme na okénko s hvězdičkou – spustí jednorázově 

prostředí Healthcare. 
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2.3 Úvodní obrazovka 

Po spuštění programu se objeví úvodní obrazovka – Start Page, která je tvořena 4 základními 

sekcemi. Popis jednotlivých sekcí je uveden níže. 

 

1. Hlavní panel s dlaždicemi 

• New Model – otevře nový model. 

• Open Model – umožní otevřít již uložený model. 

• Getting Started – otevře část návodu zaměřenou na rozvoj znalostí uživatelů 

začátečníků. 

• Preferences – otevře okno se základním nastavením programu a pracovního 

prostředí. 

• Licensing – slouží k nastavení licence. 

• User Manual – otevře manuál k SW FlexSim. 

2. Nedávné modely 

• Z této sekce je možné otevřít poslední uložené modely. 

3. Informace o SW 

• Sekce obsahuje informace o verzi SW, typu licence, ovladačích grafické karty 

a instalovaných modulech. 

• V případě, že na prvním řádku vedle verze SW svítí žlutý trojúhelník 

s vykřičníkem, je k dispozici nová verze SW. S ohledem na to, že nová verze SW 

vychází relativně často, stačí aktualizaci provádět cca za 1-3 měsíce, ani to 

však není zcela nutné. 
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4. Začínáme s programem 

• Take a Product Tour – animovaný průvodce základním použitím SW, 

respektive tvorbou modelu. 

• Explore Tutorials – otevře okno návodu pro tvorbu ukázkových modelů. 

• What’s New – otevře webovou stránku s poznámkami o novinkách v poslední 

verzi SW. 

• FlexSim in Education – otevře webovou stránku s informacemi o studentské 

licenci. 
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2.4 Návod 

Obsahem takřka každého SW, stejně tak i SW FlexSim je návod. Jeho obsahem je zejména 

základní popis objektů včetně jejich použití a popis práce s programem. Návod existuje 

jednak ve formě návodu obsaženého přímo v SW, ale také jako online návod na internetu. 

Návod můžeme spustit několika způsoby: 

1. Na úvodní obrazovce klikneme na dlaždici User Manual. 

2. Na horním panelu programu klikneme na Help > User Manual. 

3. Na horním panelu uprostřed klikneme na druhou ikonu zprava – zelené kolečko 

s otazníkem uprostřed. To nám spustí dílčí část návodu nazvanou Getting Started. 

4. Ve webovém prohlížeči zadáme adresu online manuálu: https://docs.flexsim.com/ 

 

Pokud spustíme nápovědu jedním ze tří prvních způsobů, zobrazí se nám nový panel 

s nápovědou a panel s obsahem nápovědy. Nápovědu je možné prohledávat podle 

vlastních klíčových slov, pomocí rejstříku klíčových výrazů nebo tematicky řazeného obsahu. 

 

https://docs.flexsim.com/
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2.5 Vypnutí SW FlexSim 

Vypnutí programu je možné provést 2 způsoby. (Pokud byl vytvořen model, vždy následuje 

dotaz na uložení modelu.) 

1. V levém horním rohu vybrat File > Exit. 

2. V pravém horním rohu pomocí křížku. 
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3 Vytvoření, uložení, zavření a otevření modelu 

Kapitola se zaměřuje na představení způsobů vytváření nového modelu, ukládání a zavírání 

spuštěných modelů a otevírání dříve uložených modelů. 

Po prostudování této kapitoly bude uživatel schopen: 

1. Vytvořit nový model a provést nastavení základních parametrů 

2. Uložit existující model 

3. Zavřít spuštěný model 

4. Otevřít dříve uložený model 
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3.1 Vytvoření nového modelu 

Program umožňuje vytvoření nového modelu několika způsoby: 

1. Na úvodní obrazovce – Start Page pomocí dlaždice New Model. 

2. V levém horním rohu ikonou New Model. 

3. V levém horním rohu vybrat File > New Model. 

 

V rámci vytvoření nového modelu se nám otevře okno pro nastavení základních parametrů 

modelu. Zde si nastavíme potřebné jednotky a datum/čas startu simulace. Pozor, změna 

parametrů v rámci již vytvořeného modelu může být problematická. Doporučuje se toto 

nastavení provést pečlivě. Dále se doporučuje nechat zaškrtnuté políčko „Show the window 

for each new model“, aby se nám toto okno vždy objevilo při vytvoření nového modelu. 
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3.2 Uložení rozpracovaného modelu 

Uložení rozpracovaného modelu, případně uložení modelu s novým názvem je možné 3 

způsoby. Soubor se ukládá s koncovkou „.fsm“. Doporučuje se pravidelné ukládání 

rozpracovaného modelu! 

1. V levém horním rohu vybrat File > Save… (uložit). 

• V případě, že se model ukládá poprvé, objeví se nabídka na pojmenování 

souboru a výběr místa uložení. 

2. V levém horním rohu na liště programu pomocí tlačítka diskety (Save – uložit).  

• V případě prvního uložení modelu se objeví nabídka na pojmenování souboru. 

 

3. V levém horním rohu vybrat File > Save Model as… (uložit model jako). 

• Tato možnost se využívá v případě, že chceme model nově pojmenovat nebo 

např. vytvořit novou verzi s upraveným názvem. 

Při každém uložení kromě prvního se vytvoří záložní soubor se stejným jménem, ale 

s koncovkou „.fsm!“. Soubor je možné použít po přejmenování – odmazání „!“. Tato 

skutečnost je výhodná, pokud jsme udělali např. nějakou nenávratnou chybu v poslední 

verzi modelu nebo pokud se poslední verze poškodila a nejde otevřít. 

3.2.1 Vytvoření nové složky pro modely 

Pro ukládání modelu se doporučuje vytvořit si vlastní složku, a to buď na disku počítače, kam 

si uživatel běžně ukládá data, nebo např. na ploše počítače. Na flashdisk se doporučuje 

provádět zálohu uložených modelů, než jej používat pro běžné otevírání a ukládání modelů, 

na kterých se pracuje. Složku je možné vytvořit buď při prvotním uložení modelu nebo již 

předem např. přes Průzkumníka souborů – postup je v zásadě stejný. 

Vytvoření složky přes průzkumníka souborů: 

1. Otevřeme si např. Průzkumníka souborů nebo v SW FlexSim dáme Save Model as …, 

což nám otevře Průzkumníka souborů. 

2. Následně si najdeme složku, kam budeme chtít model uložit. 
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3. Ve složce, kam chceme model uložit klikneme pravým tlačítkem myši do prostoru 

složky, v nové nabídce si najedeme na Nový a vybereme Složka.  

 

Nebo pokud jsme dali Save Model as…, můžeme použít přímo tlačítko Nová složka. 

 

4. Nově vytvořenou složku pojmenujeme dle potřeby a potvrdíme tlačítkem Enter. 

Pokud jsme šli přímo přes průzkumníka, můžeme jej zavřít. Pokud jsme šli přes Save 

Model As…, klikneme dole na otevřít a pokračujeme dalším krokem. 

 



  FlexSim – Uživatelská příručka 

 

Verze 11. 03. 2023  23 

 

5. Pojmenujeme si podle potřeby v dolním řádku model a dáme uložit. 
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3.3 Zavření rozpracovaného modelu 

Program umožňuje zavření modelu 3 způsoby. V prvních dvou případech se jedná o 

ukončení celého programu. U všech tří způsobů následuje dotaz na uložení modelu. 

1. V levém horním rohu vybrat File > Exit. 

2. V pravém horním rohu pomocí křížku. 

3. Otevřením nového modelu. 
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3.4 Otevření uloženého modelu 

Otevření uloženého modelu je opět možné několika způsoby: 

1. Z úvodní obrazovky – Start Page pomocí dlaždice Open Model na levé straně. Otevře 

průzkumníka souborů a na disku si najdeme model k otevření. 

2. Z úvodní obrazovky – Start Page ze sekce Recent Models. 

3. V levém horním rohu vybrat File > Open Model… (otevřít model). 

4. V levém horním rohu přes ikonu složky. 

5. Spuštěním souboru z průzkumníka souborů, případně spuštěním dvojklikem 

z plochy, pokud jsme si tam soubor uložili. Vždy dojde k novému spuštění SW 

FlexSim. 
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4 Pracovní prostředí 

Kapitola se zaměřuje na představení uživatelského prostředí programu a jeho nejdůležitější 

části. Dále pak také na přizpůsobení pracovního prostředí potřebám uživatele. 

Po prostudování této kapitoly bude uživatel schopen: 

1. Orientovat se v pracovním prostředí 

2. Přizpůsobit pracovní prostředí vlastním potřebám 



  FlexSim – Uživatelská příručka 

 

Verze 11. 03. 2023  27 

 

4.1 Představení pracovního prostředí 

Součástí pracovního prostředí je i panel pro nastavení základních parametrů modelu 

objevující se při jeho prvotním vytvoření. Proto si ho zde připomeneme. Nastavujeme zde 

jednotky a datum/čas startu simulace. Pozor, změna parametrů, u již vytvořeného modelu 

může být problematická. Doporučuje se tedy nastavení provést pečlivě a ponechat 

zaškrtnuté pole „Show the window …“, aby se nám okno vždy objevilo u nového modelu. 

 

Nyní již přejděme k představení samotného pracovního prostředí, které je na obrázku níže. 

Prostředí můžeme rozdělit na 6 částí/panelů. Čísla na obrázku u jednotlivých částí/panelů 

odkazují na podkapitoly 4.1.x, kde je uveden bližší popis těchto částí/panelů. 
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4.1.1 Hlavní menu a hlavní panel nástrojů 

Tato sekce obsahuje podobnou nabídku jako jiné programy. Hlavní menu obsahuje 

rozevírací nabídky File, Edit, View, etc. Z pohledu uživatele začátečníka jsou důležité tyto 

nabídky, respektive některé funkce/nástroje v nich obsažené: 

• File 

o New Model – vytvoření nového modelu. 

o Open Model – otevření existujícího modelu. 

o Save a Save Model as – uložení existujícího modelu. 

o Global Preferences – nastavení SW. 

• Edit 

o Undo – zpět – vrátí akci uživatele o jeden krok zpět jako např. ve Wordu. 

o Redo – provedení akce znovu – provede akci uživatele znovu. 

o Model Settings – nastavení parametrů modelů – nedoporučuje se příliš měnit 

zejména jednotky, protože to může ovlivnit funkčnost modelu. 

• Execute (nejdůležitější nabídka pro začátečníky) 

o Model View 3D – otevření dalšího pracovního okna, které může sloužit buď 

jako pracovní nebo pouze pro jiný pohled na model. 

o Open Default Workspace – nastaví pracovní prostředí do původního rozvržení 

včetně pohledu uživatele na model. 

o Drag-Drop Library, Toolbox, Quick Properties – při kliknutí na tyto nabídky si 

můžeme tyto panely otevřít, pokud jsme si je zavřeli. Pokud jsou panely 

otevřené jsou tyto nabídky světle modře podbarveny. 

o Find Objects – slouží k nalezení objektů v modelu. 

• Help 

o User Manual – spustí uživatelský manuál. 

 

Hlavní panel nástrojů tvoří sada ikon pro nejdůležitější činnosti uživatele při tvorbě modelu. 

Význam těchto ikon je následující: 

1. Vytvoření nového modelu, Otevření a Uložení stávajícího modelu. 

2. Ikony pro propojování objektů (bližší popis v další kapitole). 

3. Otevření nového pracovního okna. 

4. Dashboards – slouží k tvorbě grafů a statistik, Process Flow – otevírá tvorbu procesů, 

ikona s 3 čtverečky slouží k otevření nastavení flowitems (objektů putujících 

modelem). 

4.1.2 Panel pro ovládání simulace 

Jak název napovídá, panel slouží k ovládání a nastavení simulace – simulačního běhu. Panel 

má tři sekce. 

 

1. Ovládání simulace se 4 tlačítky. 
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• Reset slouží k nastavení času simulace na 0, vynulování statistik, odstranění 

materiálových toků, … 

• Run slouží ke spuštění simulace. 

• Stop slouží k pozastavení simulace 

• Step slouží k posunutí modelu o jednu událost vpřed. 

2. Run Time – jedná se o simulační hodiny, které zobrazují aktuální čas. Součástí je 

rozbalovací nabídka pod šipkou vpravo, kde je možné nastavit typ zobrazení času, 

čas zastavení simulace nebo zahřívací dobu. 

3. Run Speed – slouží k nastavení rychlosti běhu simulace. Rychlost je možné nastavit 

buď pomocí lišty s posuvným jezdcem nebo při kliknutí na šipku pomocí násobků 

času (1 = reálný čas, maximum = násobek odpovídající max. výkonu PC). 

4.1.3 Pracovní okno pro vytváření 3D modelu 

Pracovní okno představuje prostor pro modelování – vytváření 3D modelu. Prostor 

pro modelování je vlastně nekonečná mřížková plocha, kde rozměry jednoho čtverečku 

mřížky jsou definovány jednotkou nastavenou při vytvoření nového modelu (viz začátek 

podkapitoly 4.1). Černý kříž na mřížce označuje počátek, kde x = 0, y = 0 a z = 0. Směr x je 

vlevo a vpravo, směr y je dopředu a dozadu a směr z je nahoru a dolů. 

Uživatel může mít otevřeno i více pracovních oken, respektive pohledů na model. Jedním ze 

způsobů, jak je vytvořit, je, že v nabídce View klikneme na Model View 3D nebo na hlavním 

panelu nástrojů klikneme na ikonu mřížky s popiskem 3D. U obou možností se nám následně 

otevře nové okno. Další možnosti, jak pracovat s pohledy na model, budou představeny 

v další kapitole. 

Nový 3D model a jeho struktura se vytváří vkládáním objektů z knihovny objektů (viz Kap. 

4.1.4).  

K pohybu v pracovním okně se používá myš. Levé tlačítko myši posouvá pohled doleva a 

doprava, pravé tlačítko myši pohled natáčí, kolečko myši pohled přibližuje a oddaluje. 

Alternativně lze k přiblížení a oddálení pohledu použít podržení levého i pravého tlačítka 

myši najednou a zároveň pohybu myší od sebe a k sobě. 

 

4.1.4 Knihovna objektů a knihovna nástrojů 

Jak bylo napsáno výše, nový 3D model a jeho struktura se vytváří vkládáním objektů 

z knihovny objektů (Library), která seskupuje objekty do kategorií: Fixed Resources (fixní 

zdroje – stroj, buffer, …), Task Executers (vykonavatele úkolů – pracovník, robot, …) Conveyors 

(dopravníky), … Do SW je také možné nahrávat i další typy knihoven buď vlastních objektů 

nebo např. od externích subjektů. Vedle knihovny objektů se pak nachází knihovna nástrojů. 
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Zde se nachází nástroje, které pomáhají vytvářet model, jako jsou tabulky, listy, dashboardy 

pro zobrazení grafů atd. 

 

4.1.5 Panel pro rychlé nastavení vlastností/parametrů 

Tento panel slouží k rychlému základnímu nastavení vlastností a parametrů pracovního 

okna a zejména jednotlivých objektů vložených do modelu. Když chceme provést nastavení 

vybraného objektu, nemusíme tak otevírat jeho detailní nastavení, ale můžeme provést 

nastavení přímo v tomto panelu. U objektu – stroje (procesu) tak můžeme v tomto panelu 

velice rychle nastavovat jméno objektu, procesní čas, seřizovací čas nebo např. pozici v 

modelu. U pracovního okna potom můžeme zobrazovat mřížku, jména objektů v modelu 

nebo např. propojení objektů. 

4.1.6 Panel s počtem použitých objektů 

Panel ukazuje aktuální počet objektů použitých v modelu a naplnění limitu 30 objektů, které 

je možné v modelu u verze SW FlexSim Express maximálně použít. Panel je pouze ve verzi 

FlexSim Express. 
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4.2 Organizace – přizpůsobení pracovního prostředí 

Pracovní prostředí je možné dle potřeby přizpůsobit. Panely/okna jsou dokovací a je možné 

si je rozmisťovat a ukotvovat dle vlastních potřeb. Dále si je můžeme přesouvat „mimo SW“ 

např. na druhý displej. V případě potřeby je můžeme i zavírat pro více místa na displeji, a to 

křížkem v jejich pravém rohu. 

Postup přesunutí nebo ukotvení je následující: 

1. Chytíme pravým tlačítkem myši panel, který chceme někam přemístit, a zatáhneme 

za něj (pohneme s ním) požadovaným směrem. Jako ukázku si vybereme Toolbox. 

 

2. Panel se uvolní a můžeme ho přesunout např. na druhý displej a tam ho ponechat. 

Nebo ho můžeme ukotvit jinam – viz další krok. 

3. Panel se uvolní a objeví se nám nabídka možných ukotvení (viz obrázek). V případě, 

že najedeme na pravou nebo levou stranu, objeví se nám větší záměrný kříž, který 

nám umožňuje umístit jednotlivé panely přes sebe, vedle sebe nebo nad/pod sebe.  

 



  FlexSim – Uživatelská příručka 

 

Verze 11. 03. 2023  32 

 

 

4. Pokud následně najedeme na vybranou pozici a panel pustíme, ukotví se do vybrané 

pozice. Panel Toolbox v tomto případě ukotvíme pod panel Library – viz zelená šipka 

na předchozím obrázku. 
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5 Základy práce v pracovním prostředí 

Kapitola se zaměřuje na osvojení si základní práce se SW FlexSim, respektive základní práce 

v pracovním prostředí a pracovním okně.  

Po prostudování této kapitoly bude uživatel schopen: 

1. Pohybovat se v pracovním okně 

2. Pracovat s objekty z knihovny 

3. Propojovat objekty 

4. Nastavovat pohledy na model 
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5.1 Základní terminologie 

Než přistoupíme k základní práci v pracovním prostředí bude vhodné se krátce seznámit 

s nejdůležitější terminologií SW FlexSim. 

Model je soubor FlexSim objektů reprezentujících modelovaný systém, s odpovídajícím 

detailem nutným pro zodpovězení základních otázek. 

Object je stavební blok s dědičným chováním a uživatelsky definovanými vlastnostmi, 

proměnnými a vizuálními vlastnostmi. 

• FixedResources – objekty přijímající, zpracovávající, odesílající, … flowitems 

• TaskExecuters – mobilní zdroje vykonávající přidělené úkoly 

• Flowitem 

Flowitem je entita pohybující se modelem, může se jednat o výrobek, zákazníka, telefonní 

hovor, dokument, … Nositel informací (možnost definovat vlastnosti, proměnné, vizuální 

vlastnosti). 
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5.2 Pohyb v pracovním okně 

K pohybu v pracovním okně se používá myš. Levé tlačítko myši posouvá pohled doleva a 

doprava, pravé tlačítko myši pohled natáčí, kolečko myši pohled přibližuje a oddaluje. 

Alternativně lze k přiblížení a oddálení pohledu použít podržení levého i pravého tlačítka 

myši najednou a zároveň pohybu myší od sebe a k sobě. 
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5.3 Práce s objekty z knihovny 

5.3.1 Vkládání objektů 

Existují 4 základní nejčastěji používané způsoby vkládání objektů do modelu: 

1. Přetažení: Přetažením objektů z Library (knihovny) vlevo. 

2. Vícenásobné vložení: Pouze klikneme na objekt v knihovně (někdy je třeba dvojklik) 

a najedeme nad plochu modelu. Kurzor myši se nám změní na křížek s touto ikonkou 

 a pak můžeme vkládat nepřerušovaně více objektů stejného typu najednou. 

Tento mód vypneme tlačítkem Esc. 

3. Vložení z plochy: Dvakrát klikneme do plochy modelu a objeví se nám okno 

s knihovnou, kde si vybereme požadovaný objekt a klikneme na něj. 

4. Zkopírování objektu již vloženého do modelu: Vybereme si požadovaný objekt – 

kolem objektu se udělá žlutý rámeček. Zmáčkneme Ctrl+C, čímž objekt zkopírujeme 

a následně zmáčkneme Ctrl+V, čímž vložíme kopii objektu. Takto vložený objekt má 

vlastnosti původního objektu. 

5.3.2 Změna velikosti objektů 

U vložených objektů můžeme měnit jejich velikost v každé ze tří os. K dispozici máme dva 

způsoby: 

1. Změna pomocí kuželů: Když vybereme objekt, u kterého chceme měnit jeho velikost, 

objeví se nám okolo tohoto objektu žlutý rámeček a dále na každé straně malé 

kužely. Pokud levým tlačítkem myši tyto kužely uchopíme a pohneme s nimi 

v požadovaném směru, objekt změní v daném směru svou velikost. 

2. Změna číselnou hodnotou: Když vybereme objekt, u kterého chceme měnit jeho 

velikost, můžeme vpravo v panelu rychlého nastavení provést přesné nastavení 

potřebné velikosti objektu. Pole odpovídají tomuto pořadí os: x,y,z. 

 

5.3.3 Natáčení objektů 

Vložené objekty můžeme dle potřeby natáčet okolo jednotlivých os. K dispozici máme dva 

způsoby: 

1. Natočení pomocí kuželů: Když vybereme objekt, u kterého chceme měnit jeho 

velikost, objeví se nám okolo tohoto objektu žlutý rámeček a dále na každé straně 

malé kužely. Pokud pravým tlačítkem myši tyto kužely uchopíme a provedeme pohyb 

podobný otáčení, objekt se natočí. 



  FlexSim – Uživatelská příručka 

 

Verze 11. 03. 2023  37 

 

2. Natočení číselnou hodnotou: Když vybereme objekt, u kterého chceme měnit jeho 

velikost, můžeme vpravo v panelu rychlého nastavení provést přesné nastavení 

potřebného úhlu natočení objektu. Pole odpovídají natočení okolo těchto os: x,y,z. 

Hodnota se samozřejmě zadává ve stupních (bez jednotky). 

 

5.3.4 Rozmístění objektů 

Rozmístění objektů můžeme provést buď: 

1. Přetažením: Prostým přetažením objektů po ploše modelu pomocí myši. 

2. Nastavením hodnoty: Nebo můžeme provést nastavení konkrétní pozice vpravo 

v panelu rychlého nastavení. Pole odpovídají pořadí os x,y,z a vyplňovaná hodnota je 

vzdálenost referenčního bodu objektu vůči středu pracovní plochy (středu modelu). 

Referenční bod objektu je možné dle potřeby měnit – viz krychlička vedle 

jednotlivých polí. Aktuální referenční bod je podbarven světle modře. 

 

5.3.5 Základní rychlé nastavení objektů 

Jednou z velkých výhod SW FlexSim je, že vybraná nejdůležitější nastavení objektů je možné 

provádět v panelu rychlého nastavení vlastností na pravé straně pracovního prostředí. Stačí 

pouze kliknout na objekt, který chceme nastavovat a přesunout se k tomuto panelu. 

Nemusíme tak vstupovat do detailního nastavení objektu a neztrácíme tím čas, nicméně 
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v případě potřeby detailnějšího nastavení se bez toho již neobejdeme. Skrze panel rychlého 

nastavení vlastností můžeme nastavovat např.: 

1. Statistiky, které budeme sledovat na Dashboardu (panel s grafy atp.). 

2. Název, pozici, natočení a rozměry objektu. 

3. Max. kapacitu objektu, procesní a seřizovací časy. 

4. Výstupní strategii z objektu.  

 

5.3.6 Záměna 3D modelu objektu 

Bude doplněno v budoucnu. 

5.3.7 Vložení vlastního objektu 

Bude doplněno v budoucnu. 
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5.4 Propojování objektů 

K propojování jednotlivých objektů slouží tzv. porty. Porty mohou být trojího typu a to 

Output/Input Ports (výstupní a vstupní) a Central Ports (centrální). 

5.4.1 Výstupní/Vstupní porty (Output/Input Ports) 

Propojení výstupního portu jednoho objektu a vstupního portu jiného objektu definuje 

potenciální cestu entity modelem z jednoho pracoviště na jiné. Objekt může mít neomezený 

počet portů. Propojení portů je nutné pro každou potenciální cestu entity modelem. Port, 

kterým Flowitem vystoupí je dán výstupní strategií (výstupními pravidly). Output/Input Ports 

mají tvar trojúhelníčku a výstupní je červený, vstupní je zelený. 

 

5.4.2 Centrální porty (Central Ports) 

Slouží typicky k připojení Task Executers (vykonavatelé úkolů), kteří jsou přivoláni ke 

zpracování nebo transportu Flowitem. Task Executers mohou být např. pracovníci, vozíky 

atp. Central Ports mají tvar čtverečku a jsou vždy červené. 
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5.4.3 Postup propojení 

K propojení objektů a jejich rozpojení můžeme použít 2 způsoby: 

1. Pomocí klávesové zkratky a levého tlačítka myši. Do kurzorového módu se pak 

vrátíme tak, že pustíme klávesu na klávesnici. 

 Outputs to Inputs Center to Center 

Connect (propojení) A S 

Disconnect (rozpojení) Q W 

View V C 

2. Pomocí menu panelu v horní části. Do kurzorového módu se pak vrátíme kliknutím na 

kurzor v horní části nebo opět tlačítkem Esc. 

 

5.4.4 Pravidla propojování 

Při propojování jednotlivých objektů je třeba si dávat pozor, jaké objekty, respektive porty 

propojujeme! Je nutné dodržovat následující pravidla: 

1. V případě, že propojujeme nebo rozpojujeme Output/Input Ports: 

• Propojení se provádí ve směru z Output Port jednoho objektu do Input Port 

jiného objektu. 

• Rozpojení se provádí opět ve směru z Output Port jednoho objektu do Input 

Port jiného objektu. 

2. V případě, že propojujeme nebo rozpojujeme Central Ports: 

• Propojení se provádí ve směru z fixního objektu (např. stroj) k Task Executers 

(např. pracovník). 

• Rozpojení je možné provést v obou směrech. 

Pozor při propojování může nastat ještě jedna specifická situace, a to, když využíváme tzv. 

Dispatcher – dispečer. Tento objekt slouží, jak sám název napovídá k řízení Task Executers. 

Pak je postup propojování následující: 

• Když propojujeme fixní objekt a Dispatcher, postupujeme jako v případě 2. 

• Když propojujeme Dispatcher a např. pracovníka tak, s ohledem na to, že tyto objekty 

jsou ze stejné skupiny objektů Task Executers, postupujeme jako v případě 1. 
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5.5 Nastavení pohledu na model 

Se složitostí vytvořeného modelu roste potřeba přizpůsobit si pohled na model. Řešení 

mohou být opět různá a závisí na potřebách uživatele: 

1. Výběr přednastaveného pohledu 

• Klikneme pravým tlačítkem myši do volného prostoru modelu a 

vybereme nabídku Model Views a zde si vybereme požadovaný pohled. Volba 

Front nastaví základní pohled, který máme nastaven, když vytvoříme nový 

model. 

 

2.  Reset pohledu 

• Klikneme pravým tlačítkem myši do volného prostoru modelu a vybereme 

nabídku View a zde můžeme vybrat Reset View (vrátí základní pohled) nebo 

Reset View Rotation (zresetuje pouze nastavenou rotaci). 
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3. Otevření dalšího pohledu 

• Další pohled – pracovní okno si můžeme otevřít buď z hlavního menu View > 

Model View 3D nebo pomocí ikony mřížky s popiskem 3D na hlavním panelu 

nástrojů. Pozor velké množství těchto oken spotřebovává větší výkon PC. 
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6 Vytvoření/nastavení vlastnosti u flowitem 

Jak bylo napsáno v Kap. 5.1, u entit pohybujících se modelem (flowitem) můžeme definovat 

jejich vlastnosti. Vlastnost může mít flowitem vytvořenu již před samotným vygenerováním 

nebo můžeme vlastnosti vytvořit (nastavovat) v průběhu simulace. 

Po prostudování této kapitoly bude uživatel schopen: 

1. Vytvořit/nastavit vlastnost u flowitem před vygenerováním 

2. Vytvořit/nastavit vlastnost u flowitem v průběhu simulace 
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6.1 Vytvoření/nastavení vlastnosti u flowitem před vygenerováním 

Pokud chceme vytvořit vlastnost u flowitem, aby flowitem měl tuto vlastnost již při 

vygenerování, postupujeme následujícím způsobem: 

1. Nahoře na panelu nástrojů klikneme na čtvrtou ikonu zprava se třemi čtverečky. 

Otevře se nám tzv FlowItem Bin – schránka s různými druhy flowitems. 

 

2. Zde si vybereme potřebný flowitem a dáme zkopírovat – nahoře klikneme na dva 

listy. Nebo klikneme na zelené plus a zde vybereme New Basic FlowItem. Vždy se 

doporučuje dělat kopii nebo nový flowitem a neupravovat původní flowitem! 

 

3. Vytvoří se nám nový Box. Ten si dle potřeby přejmenujeme vpravo na panelu rychlého 

nastavení. 
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4. Nyní přidáme vlastnost. Na panelu rychlého nastavení se přesuneme k sekci Labels a 

klikneme na zelené plus. 

 

5. Vybereme typ vlastnosti, jestli daná vlastnost bude mít hodnotu číslo (např. 50 cm) 

nebo jestli hodnota vlastnosti bude řetězec (např. zmetek). Jinými slovy zda se bude 

jednat např. o číslo (Number) nebo např. řetězec písmen (String). 

6. Vytvoří se nám nové pole. Klikneme do něj a vyplníme název vlastnosti (buňka vlevo) 

a hodnotu (buňka vpravo) a dáme Enter. 

 

7. Vlastnost je vytvořena. 

8. Ještě musíme nastavit, aby se nám ze zdroje (source) generoval náš nový flowitem 

s naší nově nadefinovanou vlastností. Vstoupíme do modelu (klikneme na záložku 

Model). 
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9. Dvojklik na Source. 

10. Vybereme záložku Source, zde FlowItem Class a z otevřené nabídky si vybereme náš 

nový flowitem. Potvrdíme Apply a OK. 

 

11. Pustíme simulaci a po chvilce ji zastavíme. Klikneme na vygenerovaný flowitem a 

vpravo na panelu rychlého nastavení můžeme zkontrolovat naši vlastnost – Label. 
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6.2 Vytvoření/nastavení vlastnosti u flowitem v průběhu simulace 

Pokud chceme vytvořit/nastavit vlastnost u flowitem v průběhu simulace, tzn., např. aby se 

v průběhu simulace měnila např. barva, kvalita atp., tak nastavení se provádí v rámci nějaké 

události. Takovou událostí může být např. vstup nebo výstup flowitem ze stroje. Nemusí se 

samozřejmě jednat čistě o vytvoření vlastnosti, ale rovněž může jít o změnu hodnoty 

vlastnosti vytvořené podle předchozí kapitoly. Jak se provede vytvoření/nastavení vlastnosti 

v průběhu simulace je popsáno dále:  

1. Vybereme si objekt, v rámci kterého provedeme nastavení vlastnosti u flowitem. 

Např. Processor – stroj. 

2. Vybereme si záložku Triggers a klikneme na zelené plus. 

3. Zde si vybereme, kdy k vytvoření/nastavení vlastnosti dojde. Např. na výstupu 

z objektu (On Exit), na vstupu do objektu (On Entry), při dokončení procesu (On 

Process Finish) atd. 

 

4. Přidá se nám nový řádek a zde klikneme na zelené plus a vybereme si, co za vlastnost 

a jak budeme nastavovat. Zde např. budeme měnit barvu. Vybereme tedy Visual > 

Set Object Color (nastavit barvu objektu). (Pokud bychom chtěli např. měnit nějakou 

datovou vlastnost, jako např. velikost z předchozího příkladu, vybereme sekci Data > 

Set Label.) 
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5. Objeví se nám nové okno a nastavení v druhém řádku buď ponecháme jako random 

(náhodné) nebo nastavíme konkrétní barvu. 

 

6. Podle potřeby můžeme nastavit i více vlastností najednou. Jak datových, tak např. 

vizuálních dohromady. 

7. Potvrdíme Apply a OK. 

8. Pustíme simulaci a zjistíme, zda vše funguje. Provedeme vizuální kontrolu. Případně 

i kontrolu vlastností (viz předchozí kapitola, krok 11). 
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7 Způsoby nastavení času 

Kapitola představuje různé způsoby, jak nastavit hodnotu procesních či seřizovacích časů. 

Vysvětleno je např. použití pravděpodobnostních rozdělení. 

Po prostudování kapitoly bude uživatel schopen nastavit čas: 

1. Pomocí pravděpodobnostního rozdělení 

2. V závislosti na konkrétním typu flowitem (Bude doplněno později.)  

3. Pomocí tabulky (Bude doplněno později.) 

4. … 

 



  FlexSim – Uživatelská příručka 

 

Verze 11. 03. 2023  50 

 

7.1 Nastavení času pomocí pravděpodobnostního rozdělení 

Čas, ať už procesní nebo seřizovací, můžeme nastavit i pomocí pravděpodobnostního 

rozdělení. Bez ohledu na to, zda nastavujeme čas v panelu rychlého nastavení na pravé 

straně pracovního prostředí nebo v detailním nastavení objektu, postup je vždy stejný. 

Jednotlivé kroky postupu jsou uvedeny dále: 

1. Napravo vedle pole, kde se vyplňuje čas, klikneme na šipku dolů. 

 

2. Z nabídky vybereme Statistical Distribution. 

3. Zde si vybereme požadované statistické rozdělení např. Exponential. 
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4. Objeví se tabulka, kde vyplníme potřebné hodnoty: 

• Location – začátek rozsahu rozdělení 

• Scale – střední hodnota určující sklon křivky 

• Stream – obvykle se nemění, slouží ke stanovení náhodných čísel 

 

5. Při změně hodnot se překreslí křivka rozdělení. 

6. Pokud jsme hotoví, klikneme mimo tabulku. V případě, že jsme vstoupili dvojklikem 

do detailního nastavení, potvrdíme nastavení tlačítkem Apply a OK. 

7. Pokud bychom chtěli nastavení změnit, tak klikneme na ikonu ruky s listem vedle 

šipky, přes kterou jsme se dostali k nastavení statistického rozdělení. 

 

8. Pozor, důležité upozornění, hodnoty je třeba zadávat ve správných jednotkách, které 

jsme si vybrali při vytváření modelu. Viz Kap. 4.1. 
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7.2 Nastavení času dle vlastnosti flowitem 

V případě, že budeme chtít nastavovat výrobní čas podle vlastnosti flowitem, což může být 

např. jméno, ale i jiná vlastnost, tak postupujeme následujícím způsobem: 

1. Napravo vedle pole, kde se vyplňuje čas, klikneme na šipku dolů. 

 

2. Z nabídky vybereme Value By Case. 
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3. Objeví se nám nová nabídka. V nabídce nastavíme do pole Value název (typ) 

vlastnosti, na základě které budeme stanovovat čas. Tato vlastnost se zapisuje za 

řetězec „item.“. Celý řetězec „item.název_vlastnosti“ pak vlastně slouží k tomu, aby 

mohl SW ověřit, jakých hodnot vlastnost nabývá. V obrázku níže pracujeme 

s vlastností Stav. 

 

4. Dále vyplníme pole Case a Time. Do pole Case vyplňujeme hodnotu, kterou daná 

vlastnost u flowitem nabývá. Zde máme situaci, že vlastnost nabývá hodnot 1 nebo 

2. Do pole Time nastavíme konkrétní hodnotu času pro hodnotu vlastnosti. Zde tedy: 

• Pokud vlastnost flowitem má hodnotu 1, pak bude výrobní čas 10 min. 

• Pokud vlastnost flowitem má hodnotu 2, pak bude výrobní čas 5 min. 

 

5. Pokud potřebujeme přidat řádek, klikneme na zelené plus. 

6. Pokud se potřebujeme vrátit k nastavení, tak klikneme na ruku s listem vedle podle 

Process Time. 

7. Nastavení potvrdíme nastavení tlačítkem Apply a OK. 

8. Pozor, důležité upozornění, hodnoty je třeba zadávat ve správných jednotkách, které 

jsme si vybrali při vytváření modelu. Viz Kap. 4.1. 
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8 Nastavení výstupní strategie z objektů 

Výstupní strategie určuje, jak/kam budou jednotlivé flowitem vystupovat z objektů, 

respektive jaký bude materiálový tok v rámci modelu. V rámci této kapitoly jsou některé 

výstupní strategie vysvětleny. 

Po prostudování kapitoly bude uživatel schopen nastavit tyto výstupní strategie: 

1. Náhodná s procentuálním rozdělením 

2. Strategie založená na vlastnostech flowitem 

3. … 
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8.1 Nastavení strategie a typy strategií 

Výstupní strategie se nastavují v detailním nastavení objektu, na které se dostaneme 

dvojklikem na objekt. Zde se vybere záložka Flow a v sekci Send To Port se klikne na šipku 

dolů. Následně se nám objeví nabídka výstupních strategií. 

 

Dále je uveden seznam vybraných výstupních strategií, které můžeme nastavit, včetně jejich 

stručného popisu: 

• First Available – Flowitem odeslán na první volný = dostupný objekt (port) v pořadí. 

• Shortest Queue – Strategie odesílá flowitem na takový objekt (port), kde se čeká 

nejkratší fronta, respektive kam putovalo nejméně výrobků. 

• Shortest Queue if Available – Strategie odesílá flowitem na takový objekt (port), kde 

se čeká nejkratší fronta, respektive kam putovalo nejméně výrobků, ale pouze tehdy, 

pokud je tento objekt (port) dostupný. 

• Longest Queue if Available – Strategie odesílá flowitem na takový objekt (port), kde 

se čeká nejdelší fronta, ale pouze tehdy, pokud je tento objekt (port) dostupný. 

• Random Port – Odesílání flowitem na náhodný port (objekt). 

• Random Available Port – Odesílání flowitem na náhodný port (objekt). Pokud tento 

port (objekt) není dostupný, je flowitem odeslán na jiný náhodně zvolený port 

(objekt). 

• Random By Percentage – Náhodné odesílán flowitems na následující objekty podle 

procentuálního rozdělení. 

• Round Robin – Flowitem jsou postupně odesílány cyklicky na jednotlivé porty 

(objekty) tak, jak jsou za sebou napojeny.  

• Round robin if Available – Pokud je předchozí strategie doplněna o „if Available“ (v 

případě dostupnosti) pak v případě, že je objekt, kam má být flowitem odeslán, 

obsazen, tak je flowitem odeslán na další objekt v pořadí. 

• Port By Case – Strategie posílá flowitem na následující objekty v závislosti na nějaké 

nastavené vlastnosti u flowitem (např. vlastnost zmetek). 

• Conditional Port – Výstupní strategie založená na podmínce – „když …, tak …“ a „když 

… ne, tak …“. 

• … (Další strategie budou doplněny případně později.) 
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8.2 Výstupní strategie náhodná s procentuálním rozdělením 

Tato strategie (Random By Percentage) jednotlivé flowitem vystupující z objektu náhodně 

posílá na objekty, které jsou k tomuto objektu ve směru materiálového toku připojeny. 

Odesílá je v procentuálních proporcích, které uživatel nastaví. 

Tato strategie je vhodná např. u procesů kontroly kvality, kde víme, že určité procento 

výrobků jsou zmetky a tyto výrobky chceme poslat např. na opravu. Viz následující obrázek. 

 

Postup nastavení výstupní strategie náhodné s procentuálním rozdělením (Random By 

Percentage) u problému na předchozím obrázku: 

1. Exit strategie se vždy nastavuje v objektu, ze kterého mají flowitem vystupovat. 

Otevřeme si tedy dvojklikem levým tlačítkem myši nastavení objektu. Zde Kontrola 

kvality. 

2. Jdeme na záložku Flow. 
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3. Zde v části Output klikneme na šipku vedle pole nazvaného Send To Port. V nabídce 

vybereme strategii Random (náhodná) a v další nabídce By Percentage 

(procentuálně). 

 

4. V nové nabídce nyní pomocí procentuálních hodnot nastavíme, jaký objem výrobků 

bude směřovat na jaký výstupní port z objektu Kontrola kvality, respektive na jaký 

následující objekt. 

 

5. Pokud potřebujeme přidat řádky pro další porty, klikneme na velké zelené plus 

nahoře v nabídce. 

6. V rámci našeho příkladu budeme předpokládat, že 90 % výrobků je OK a pošleme je 

do skladu, tedy na Port 1. 10 % budeme předpokládat, že jsou zmetky a pošleme je 

na opravu, tedy na Port 2. 
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7. Kam který port směřuje (na který objekt) vidíme na obrázku (1. port – horní 

trojúhelníček na Výstupní sklad, 2. port na spodní trojúhelníček na Opravu). Případně 

se můžeme přesvědčit na záložce General, dole v sekci Ports, Output Ports. 

 

8. Pokud se potřebujeme vrátit k nastavení strategie, klikneme na ikonu ruky s listem. 

 

9. Pokud jsme hotovi, klikneme na Apply a OK. 

10. Funkčnost strategie můžeme ověřit např. pomocí statistik nebo alespoň vizuálně. 
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8.3 Výstupní strategie založená na vlastnostech flowitem 

Tato strategie (Port By Case) odesílá flowitem na následující objekt v závislosti na tom, zda 

daný flowitem má nějakou předem danou vlastnost. Příkladem může být např. typ výrobku, 

kdy každý výrobek má svůj vlastní materiálový tok. 

Začátek postupu je podobný, jako u ostatních strategií: 

1. Exit strategie se vždy nastavuje v objektu, ze kterého mají flowitem vystupovat. 

Otevřeme si tedy dvojklikem levým tlačítkem myši nastavení objektu. Zde Kontrola 

kvality. 

2. Jdeme za záložku Flow. 

 

3. Zde v části Output klikneme na šipku vedle pole nazvaného Send To Port. 

4. V nabídce vybereme strategii Port By Case. 
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5. Objeví se nám nová nabídka. Zde musíme nastavit vlastnost, na základě které 

budeme odesílat flowitem na následující objekty. Tato vlastnost se vyplňuje v poli 

Value. Vlastnost je uvedena za hodnotou „item.“, v tomto případě se jedná o vlastnost 

„Type“. Dále vyplňujeme hodnotu vlastnosti = pole Case a pro daný Case následně 

Port. Na obrázku níže tedy říkáme, že pokud má naše vlastnost Type hodnotu = 1 

(pole Case), tak potom dojde k odeslání této flowitem na Port 1. 

 

6. Kam který port směřuje (na který objekt) vidíme na obrázku. Případně se můžeme 

přesvědčit na záložce General, dole v sekci Ports. 
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7. Pokud se potřebujeme vrátit k nastavení strategie, klikneme na ikonu ruky s listem. 

 

8. Pokud jsme hotovi, klikneme na Apply a OK. 

9. Funkčnost strategie můžeme ověřit např. pomocí statistik, vizuálně nebo kontrolou 

vlastnosti dané flowitem na panelu rychlého nastavení vpravo (viz Kap. 6.1). 
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9 Použití a nastavení vybraných objektů 

Kapitola se zaměřuje na použití vybraných objektů a detailnější nastavení některých jejich 

funkcí.  

Po prostudování této kapitoly bude uživatel schopen použít tyto objekty: 

1. Combiner 

2. Separator 

3. … 
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9.1 Combiner 

Objekt Combiner slouží k nakládání výrobků na palety nebo ke spojování různých flowitem 

dohromady, případně k vytváření dávek (objekt počká na nastavené množství a pak ho 

odešle dál). 

 

Zaměříme se dále na případ, kdy budeme nakládat výrobky na paletu. Postup nastavení je 

následující: 

1. Jako první se ke Combineru připojuje objekt, ze kterého přichází paleta. Vždy! Paletu 

je samozřejmě předtím třeba někde vygenerovat. 

2. Následně teprve připojíme objekt či objekty, odkud přichází nakládané výrobky. 

3. Otevřeme si nastavení objektu a vybereme záložku Combiner. 

4. Nastavíme v prvním řádku Combine Mode na Pack (balení). 

 

5. V tabulce dole – Components List nastavíme počet kusů, které budeme nakládat 

z jednotlivých vstupních portů. 

6. Potvrdíme Apply a OK. 
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9.2 Separator 

Objekt Separator slouží k vybalování nebo rozdělování objektů. Např. tedy k vyskládání 

výrobků z palety. 

 

Zaměříme se dále na případ, kdy budeme „vykládat“ výrobky z palety. Postup nastavení je 

následující: 

1. Jako první připojíme k Separatoru objekt, kam budou odcházet palety! Vždy! 

2. Jako druhý připojíme objekt, kam budou odcházet výrobky z palety. 

3. Do nastavení objektu není v tomto případě nutné vstupovat. 
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10 Statistická analýza a vyhodnocení 

Kapitola se zaměřuje na tvorbu statistik, statistických tabulek a grafů a jejich nastavení. 

Po prostudování této kapitoly bude uživatel schopen: 

1. Vytvořit rychlou statistiku z panelu rychlého nastavení 

2. Vytvořit graf dle vlastních potřeb 

3. … 
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10.1 Vytvoření rychlé statistiky 

Pokud chceme vytvořit rychlou statistiku a dát ji na okno se statistikami (Dashboard), 

postupujeme následujícím způsobem: 

1. Klikneme na objekt, jehož statistiku chceme sledovat. Vybraný objekt bude mít žlutý 

rámeček. 

2. Přesuneme se doprava k panelu rychlého nastavení a rozbalíme si část Statistics. 

Vybereme si statistiku, kterou budeme chtít sledovat ve statistickém okně. Např. stav 

stroje. 

 

3. Klikneme na špendlík vedle této statistiky, pokud již máme vytvořené okno se 

statistikami, tak vybereme Pin To Dashboard. Pokud ještě okno se statistikami 

nemáme, bude k dispozici pouze nabídka Pin To New Dashboard. 

 

4. Vybereme, jak budeme chtít tuto statistiku sledovat. Jestli pouze současný stav 

(Current State) nebo budeme chtít mít např. graf vytížení (Bar Chrat nebo Pie Chart). 
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5. Statistika se připne do statistického okna (Dashboardu). Pokud je okno zavřené, tak 

se otevře. Případně vytvoří zcela znova, pokud se jedná o nové okno. 

 

6. Graf si můžeme dle potřeby přejmenovat. Dvakrát na něj poklikáme. Objeví se nové 

okno a v horním řádku přepíšeme název. 

 

7. Potvrdíme Apply a OK. 

8. Pustíme simulaci, chvíli vyčkáme a můžeme se podívat na vytvořený graf a jeho 

průběžnou změnu. 
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10.2 Vytvoření vlastního grafu 

Postup vytvoření grafu, který bude odpovídat našim potřebám je následující: 

1. Na hlavním panelu nástrojů klikneme na ikonu Dashboards. 

 

2. Vybereme si buď existující Dashboard nebo vytvoříme nový (Add a Dashboard). 

3. Objeví se nám náš Dashboard. 

4. Klikneme myší do jeho prostoru. Knihovna objektu se nám změnila na knihovnu grafů. 

 

5. Zde si můžeme vybrat graf podle potřeby. Budeme chtít např. sledovat graf vytížení 

několika strojů. Vybereme si tedy ze sekce State Templates (šablony stavových grafů) 

graf typu State Bar. Změní se nám kurzor myši. 

6. Následně klikneme do prostoru Dashboardu, kam se nám vloží náš graf. 

7. Graf si pojmenujeme podle potřeb, a to v poli, kde svítí State Bar (viz obrázek níže). 

8. Nyní budeme chtít vybrat sledované stroje. Na záložce Options v sekci Objects 

klikneme na ikonu pipety (Sampler) a klikneme v modelu na první stroj, který budeme 

chtít sledovat. Stroj se přidá do nastavení grafu. 
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9. Takt dlouho pomocí Sampleru vkládáme stroje, dokud nejsme hotovi. 

 

10. Dle potřeby si můžeme upravit barvy, případně popisky v sekci States (viz obrázek 

výše). 

11. Potvrdíme Apply a OK. 

12. Pustíme simulaci, chvíli vyčkáme a můžeme se podívat na vytvořený graf a jeho 

průběžnou změnu. 
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11 Časté problémy a důležité rady 

V této kapitole jsou popsány nejčastější problémy, které se při tvorbě modelů objevují, a 

některá jejich řešení. 

1. Zavřená knihovna, panel nástrojů nebo pracovní prostředí. 

• Viz Kap. 4.1.1 

2. Nastavení původního rozvržení panelů. 

• Viz Kap. 4.1.1 

3. Špatně nastavený procesní čas 

• Jedním z problémů může být, že hodnota procesního času byla nastavena do 

pole pro seřizovací čas. Výsledky a průběh simulace pak neodpovídají 

očekáváním. 

4. Task Executer (pracovník, vozík, …) nepracuje správně nebo vůbec 

• Pravděpodobně špatné propojení objektů – viz Kap. 5.4 
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12 Aktualizace 

Obsahem této kapitoly je shrnutí klíčových změn oproti předchozí verzi dokumentu. 

1. Vytvoření základní verze dokumentu – 31. 03. 2020 

2. Aktualizace ke stažení a instalaci SW – 15. 03. 2021 

3. Aktualizace obsahu – 09. 03. 2022 

4. Aktualizace obsahu – 11. 03. 2023 


